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Microsoft Project 2007  

Introduction 
In this module you will be introduced to Microsoft Project and its various tools and 
reports. Practicing the various tasks will facilitate learning and competence building in 
the area of project management as it pertains to task scheduling, task execution, assigning 
costs and resources, and monitoring cost and schedule. We are using MS Project 2007 as 
a tool because it is widely available as part of the MS Office suite, and also because many 
readers are familiar with its user interface. Note the latest version that will be 
commercially released is MS Project 2010.  
 

What’s Ahead 
 Starting Microsoft Project 

o Using Project Guide 
o Set up calendar and schedule 

 Developing a WBS 
o Add Tasks and Sub Tasks 
o Creating Summary Tasks 
o Editing Tasks 

 Using Gantt chart 
o Using Task Information 

Dialog Box 

 Using Filters, Creating Task 
Dependencies, Constraints, and 
Critical Path Analysis. 

 Resources: Creating a pool, 
assigning and leveling. 

 Working with Project Costs  
 Updating Project Progress 
 Generating and Printing Reports 

including Earned Value Reports 
 Key Points 

 
In The Real World 
What project management tools should I use? There are many project management tools 
for planning, organizing and managing activities which are very good. If you are 
identifying a tool for the very first time you must identify your needs first—the right type 
of tool should be selected only after your needs are clearly identified.  You should answer 
questions such as: How large is the project? What is your operating system? What types 
of reports are needed? Do you have technical staff that will assist you with using the 
project software?  Also what type of software tools is popular for my application area 
(industry)?  Then communicate with experts or study survey results such as Project 
Management Institute's Project Management Software Survey. It compares over two-
hundred project management software and presents a relative summary of functionality, 
support for schedule, resource, cost, reports, migration and integration.  
 
Who will manage and operate this project management software? With regards to the 
second question, a key determining issue is the complexity of the tool. If the project 
manager is going to be the person using the project software then it must not be complex. 
Some project management software can be very technical and junior staff or specialists 
should be used to enter data, and maintain the project.  The project manager could end up 
wasting time on the technical and administrative aspects of the software instead of 
focusing on project communications and project management. Certainly report generation 
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and basic tasks should not be a problem, but the day to day issues could be managed by 
some specialist in the project office. 
 
You may want to visit a product demo dealing with a fictitious case study about 
Fabrikant from Microsoft at this point. Click Product Demo from Microsoft. 
 
 

Starting Microsoft Project 
         
We do not describe steps to install Microsoft project. A free 30 day trial version of this 
software is currently available from Microsoft in case you don’t have the software 
already installed.  
 
  

 
 

Starting Microsoft Office Project 
Select the Start | Programs | MS Office  option in your computer. You might see the 
following programs. 

 
Here we activiate MS Office Project 2007 and we should see the main project window as 
displayed in Figure 1 below. 
 

To Get Help press the F1 Key 
A lot of questions you have can be answered using Help and then typing the text 
in the search box. There are also video tutorials here. 
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Figure 1: Main Project Window 
 
The default set up introduces the Project Guide to create a new project. This is shown in  
Figure 2: Project Guide Toolbar. 
 

 
 
Figure 2: Project Guide Toolbar 
 
 
But if you don’t wish to use the guide (showing the Wizard like steps on the left) to 
create a project you can use regular commands to get going with MS Project. This is our 
approach to introduce you to MS Project in our tutorial. However, the Wizard is useful as 
it covers the complete life-cycle of project planning and tracking using MS Project. 
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If you don’t see this Project toolbar you can activate it by clicking View | Toolbars | Project Guide. 
This is shown in  
Figure 3: Inserting the Toolbar for Project Guide.  

 
 
Figure 3: Inserting the Toolbar for Project Guide. 
 
 

Exploring the Project Guide 
Turn on the Project Guide in case it is not visible. The main Gantt View is displayed to 
the right of the Project Guide. This is the default view named after Henry Gantt, it 
graphically shows tasks and in a spreadsheet like entry table as well as a calendar display 
with bars displaying task start and finish dates. 
 
The Project Guide is a wizard that appears on the left hand side of the Gantt View. The 
wizard also displays the following menu options--Tasks, Resources, Track and Report 
above the Guide.  Tasks allow you to enter tasks. Resources will let you add resources. 
Track allows you to track project progress against your baseline. The report area allows 
you to view reports. 
 
The Figure 4: Wizard - Task Activities shows you the task activities, such as, Define the 
project, Define general working times or list the tasks, that you can perform for a project.  
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Figure 4: Wizard - Task Activities 
 
1. Open the Project Guide: Click the tasks listed on the Project Guide toolbar. The 
Resources, Track, and Report buttons on the Project Guide toolbar are listed. Click them 
and read what these options are all about. Let us start with a sample project.  
 
2. Set the project start date. Click Define the project. 
 
The Project Guide instructions are very useful. The Task pane displays specific 
information relation to the selected option. The default project start date is set at the 
current date. Click the date list arrow on the popup calendar to select a date. Select the 
last day of the month that displays 
 
3. Close the Project Guide: Click the Close button 
 
You will see commonly used buttons, such as the Link tasks, Unlink tasks and Indent 
buttons. Below the toolbar is the Entry bar, which displays entries you make in the Entry 
table, located right below the Entry text box. The Gantt chart calendar display appears on 
the right of the split bar adjacent to the entry table for WBS.   The column to the left of 
the Task name column is the Indicators column. The Indicators column displays items 
associated with each task, such as task comments. 
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Jump Start -- Create a Simple Project 
With some basics out of the way, just like swimming, we will learn when we eventually jump into the 
water. So let us do that with this quick “Project Management” project. It consists of four activities— 
Learn Project Management, Review and Present Case Studies, Do Lab Activities, Celebrate with a 
Party – we enter it into the MS Project and our view will be similar to  
Figure 5: Gantt View. Like all Microsoft Office applications you can open a new project 
by simply clicking: File New | Blank Project. Save it as “MyFirstProject”. 
 

Add Tasks 
The following tasks are added to the project.  

1. Learn Project Management - 3 days 
2. Review & Present Case Studies – 2 days 
3. Do Lab Activities – 1 day 
4. Review Concepts & Celebrate with a Party – 0.5 day 

 

 

 
 
Figure 5: Gantt View 
  

Changing Date formats 
It is possible to change date formats by clicking: Tools, Option, View.  

On Your Own 
Practice opening the Project Guide. Look at the various options  

 
Click all the buttons above and study the menu options. 
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Figure 6: Date Format Changed 
 
 
We will use the above format for our simple project. We will then use the American 
Format for date for the second case study. 
 
At this point we are ready to view the Calendar, Gantt Chart and Network Diagram. Open the View 
Bar if it is not visible. The procedure for that is displayed in  
Figure 7: Activating the View Bar.   
 

 
 

On Your Own 
 View the various options in the view bar such as Calendar and Network 

Diagram and return to the Gantt View.  
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Figure 7: Activating the View Bar 

Link Tasks 
At this point we are ready to link tasks so that it shows the project completing by the end 
of the week. 
 
Step 1: Highlight all the tasks: 

 

Step 2: Click the Link Button   or Press [Cntrl] [F2]. 
 
This should result in the following Gantt View. 
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Exploring the Project Information   
The entire project information can be explored by selecting Project | Project 
Information 
  

On Your Own 
 We want to complete the Project by Friday March 12, 2010. Make 

changes to the Project so that the lab activities are half day instead of 1 
day. 

 
 
Also add your name in the Resource Name. 
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On selecting Project Information you will see  
Figure 8: Project Summary Information. You can schedule a project from the Start Date 
or from the Finish Date. The default is the Start Date. If you select Schedule from: 
Project Finish Date it will give you a chance to change the Finish dates (at the moment 
this is not editable). 
 

 
 
Figure 8: Project Summary Information 
 
 
Also you can specify which base calendar to use for this project. The default is the base 
calendar. A base calendar can be used as a project and task calendar and uses default 
working and nonworking time for a set of resources. Note: MS Project also has resource 
calendars. A resource calendar specifies working and nonworking time for an individual 
resource.  You can apply different resource calendars to a project as well. We explore this 
in the next section. 
 
Finally you can obtain useful summary information by clicking the project statistics 
option. This will give you start and finish dates, duration (schedule), and work (total 
labor or effort required to complete the project).   
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Figure 9: Project Statistics 

 

 
 

Summary 
Congratulations! You have completed your first project. You know how to enter tasks, 
link them, add a resource, add an hourly rate to the resource and then view project 
information. You also know that projects can be scheduled from a start date or from a 
deadline finish date using the Project Information option. In the rest of the tutorial you 
will be exploring some more functionality as we add more resources and look at a case 
study that is more complex than your first project. 

On Your Own 
Click the Resource Sheet located in the View Bar (see Figure 7). 

 
 
Give Maria a standard rate of $50 per hour. 

 
Click Project Information again and view the statistics for cost. What is 
the cost of the Project? 
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Optional:  Exploring Calendar and Schedule 
This module is optional. Please review it if you are comfortable with the basics and have 
time. Organizations and projects have their own working hours. Some companies work 
on 24x7 schedule and some may have shifts with staggered starting times. To setup 
calendar and schedule for a particular project you need to enter start date and finish date 
in project information dialog box. 
 
In Options box we can setup Calendar and Schedule. 
 
To change the working time, select Tools and then Change Working Time. In the dialog 
box create a New Base Calendar and Name it. For example, our calendar shows default 
calendar. 
 
The Legend column determines items such as working days, non-working days and 
exception days. 
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Click Schedule in the above Options window and you will see the following: 
 

 
 
 

 

On Your Own 
 View the various screens dealing with Calendar and Schedules.  
 Don’t save your project after you play around with various options. 
 Note:   For our tutorial purposes we stay with the default calendar which 

is 8 hours a day of work and five days a week with Saturday and Sunday 
being a holiday. This is achieved by simply starting a new project for the 
rest of the tutorial.  
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Beyond the Basics 

Goal 
 
In this module you get an overview of project management practices as seen in Microsoft 
project.  The theoretical principles you learn can be put to practice as you create, track, 
update and report a sample case study “Project Vista” introduced in MBA Fundamentals: 
Project Management by Kanabar and Warburton published by Kaplan Publishing in 
2008. This case study is briefly reproduced below in the next section. 
Subsequently you will see snapshots of Project Vista and its commands to demonstrate 
the core feature of Microsoft Project. We don’t give you click by click or step by step 
instructions as we strongly encourage you to discover MS Project on your own. 
 

Case Study: Project Vista 
          Anita Rains works for Boston Universal Group as a project manager. The company 
is a leader in Microsoft Office applications consulting. They are known nationally for 
providing consulting, training and services involving Microsoft systems especially in 
their Office suite. They have about 200 employees and 50 laptops and 160 workstations 
at the work center.  
          With the introduction of Windows7 (improvement on Vista) in the marketplace in 
2008 there is pressure from their customers to support Windows 7 operating system.  
Boston Universal Group subsequently has decided to upgrade the operating system on 
their workstations from XP to Vista or Windows7 based on their needs. Anita has been 
asked to champion this initiative as a project manager. She has worked in the 
organization for over a decade and recalls the chaos during the upgrade to Windows XP 
from Windows 98. As a trained professional in project management, she decides to use 
the best practices as defined in the Project Management Body of Knowledge (PMBOK®) 
and leverage the power of MS Project 2007. 
 Anita creates a charter and scope statement and now comes up with the following 
outline of the WBS. She will subsequently enter the data into MS Project. 

Project Tasks  

1. Initiation 
a. Project Kickoff 
b. Gaining Sr. Management approval 
c. Determining major stake holders 

2. Planning 
a. Gathering the upgrade details from Microsoft and other sources 
b. List of applications running on a PC  
c. Check H/W compatibility and Space requirements 
d. Mock run on a test PC 
e. Test Vista compatibility  
f. Upgrade running S/W, if required 
g. Rollback plan for critical machines 

3. Execution 
a. Procurement of OS license keys 
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b. Ordering the H/W upgrades 
c. Gathering of resources 
d. Installation of the H/W and the OS 
e. Training/Helpdesk 
f. Steps for Upgrading to Windows Vista 

i.   Assess Hardware Requirements   
ii.   Backup Important Data   
iii.   Upgrade to Windows Vista 
iv. Migrate user settlings    

4. Control and Monitoring 
a. Keeping the project on schedule 
b. Keeping the cost on budget 
c. Monitoring the impact on users 
d. Resolving Issues/Concerns 

5. Closing 
a. Project Closure 
b. Lessons learnt 
c. Archiving the Project documents to the Org. Repository 

 

Resources 

See Videos based on Kanabar/Warburton Text. 

1. Introduction 
2. Resources & Cost 

Important: Project 2007 QUICK Reference Card   

 
Now that we understand the basics let us review some advanced concepts.    
 

Creating a new project - Choose File | New from the menus.  Choose either a 
Blank Project or a Project Template.   Click OK. You now see a table for data 
entry and you may enter your task list. The steps for opening an Existing Project 
are pretty straight forward: Choose File | Open from the menus. Locate the project 
file on the hard disk or external device. Click on the filename. Click Open. To 
Save: Choose File | Save from the menus.  Enter a filename.  Click Save.  
  

 
 

Use an existing project template to study what a good project plan should 
look like. There are several templates that are available like construction or 
software development. Click File New | Templates on Computer.  
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Developing a Work Breakdown Structure 
 
After you establish the project start date and calendar, you can begin to identify the 
specific activities that will need to be completed in order to produce deliverables for the 
project. 
 
As you saw in the case study Anita created a work breakdown structure (WBS) for the 
project first. Developing a WBS takes time, and it will make entering tasks into the Entry 
table easier if you develop the WBS first. It is also a good idea to establish milestones 
before entering tasks in Project 2007. 
 
To refine your work breakdown structure before you enter it into MS Project enter 
sample data in the table below.   
 
Process Group Sub-Task Duration 
Initiation  3 d 
 Project Kick-off 1d 

Determine Stakeholders 1d 
Create Project Charter 1d 

Planning   
   

  
  

Execution   
   

  
  

Control & Monitoring   
   

  
  

Closing   
   

  
  

 
  

 

On Your Own 
Complete the WBS for your tutorial project on a piece of paper or using Post-it 
notes. 
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Add Tasks and Sub Tasks 
 
Click on Task Name and enter Task description, then press Enter or click the check mark 
or simply press the down arrow to enter the next task. You will see default duration of 1 
day (with a question mark) and a Gantt bar for it. To simulate a lower level WBS or a 
sub-task you will enter Task name in the table entry area and then click the right arrow 
key ().Pressing tab is an easy way to move from field to field. 
 
 

 
 

 
Figure 10: Add Tasks for Project Vista 

Creating Summary Tasks 
 
After entering the WBS tasks in to the Entry Table, the next step is to show WBS levels 
by creating summary tasks. A summary task is like a big activity under which several 
subtasks exist. It can be collapsed or expanded as needed—managers may want to hide 
certain tasks before printing a report if they are not relevant to a meeting. Before linking 
tasks you may want to indent the non-summary tasks first. This is done by first selecting 
the sub-tasks to be indented and then pressing the Indent Button. 
 

 Note you can press Insert key this key inserts a blank row at the point of 
insertion. Important you must select the entire row. 

 And to delete a task, select the row and press the Delete key. 
 Note like all office tools you must use right mouse click in Microsoft Project 

and you will see the relevant menu options. 
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The summary tasks in our case study are Task 2 - Initiation, Task 6 - Planning, Task 12- 
Execution, Task 23 - Control and monitoring, and Task 27 – Closing. You create 
summary tasks by highlighting several rows of subtasks and indenting them. 
 

 
 

 
Figure 11: Creating Summary Tasks 

On Your Own 
To create the summary tasks: 
1. Select lower-level or subtasks:   Highlight the wanted tasks 
2. Indent subtasks: Click the Indent button (green arrow highlighted below). Or 
use ALT+Shift+Right. 
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Hide or display tasks 
 
Once the project gets to large you can hide lower level tasks. They can be displayed as 
well with a simple click.    Click Show, Select an outline level to view, Click “All 
Subtasks” to display entire project. Important toolbar buttons are illustrated in the 
diagram.   
 

 
 

On Your Own 
Indent the remaining tasks so that we have the following snapshot. 
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Click the Show menu option to display the WBS outline levels as illustrated in the figure. 
On the standard toolbar, click the Show button’s list arrow .The black bars on the Gantt 
chart represent the summary tasks. 
 
Widen the Task Name Column: Move the cursor over the right –column gridline in the 
Task Name column heading until you see the resize pointer and then double-click the left 
mouse button to resize the column width automatically to show all the text. 
 
Note: You can move the split bar to reveal a wider Entry table column. Move the split bar 
to the right to reveal the entire duration column.   
 
 You can click the (-) sign to create a summary. This becomes (+). Also you can see 
various outline levels of your WBS.  
 

 
Figure 12: Viewing WBS outline Levels 
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Entering Durations 
 
When you enter a task, Microsoft Project automatically assigns to it default duration of 
one day. Duration unit symbols include: 
 

d = days (default) 
w =weeks 
m =minutes 
h = hours 
mo or mon = months 

 
To change the default duration of 1 day, type a tasks estimated duration in the duration 
column. If you are unsure of an estimate and want to review it again later, type a question 
mark after it. For example you could enter “10d?” for a task with an estimated duration of 
10 days.  In the future you can use the Tasks With Estimated Durations filter to quickly 
see the tasks for which you need to review duration estimates. You can now type both a 
number and an appropriate duration symbol.  
 
Don’t enter durations for summary tasks as such durations are calculated automatically 
from the subtasks. Note: If you enter duration for a task and then indent it to make it a 
summary task, its duration will automatically change to match the durations of its 
subtasks.   
 
You can click the duration column and enter days. Project enters the duration and Gantt 
bar stretches to reflect the number of days. Instead of typing the duration, you can also 
point the mouse at right edge of the task bar and drag it to reflect the duration you wanted 
to assign. 

On Your Own 
View the WBS outline levels. You can click the (-) sign to create a summary. 
This becomes (+). Also see various outline levels of your WBS. See the example 
above. 
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Figure 13: Entering Durations 
 
 

 
 

Using Task Information Dialog Box 
 
The table entry view does not allow you to enter detailed information about a task. The 
task information window allows you to enter information such as: predecessors, 
resources, task constraints such as ASAP, and mark a task as milestone. You click Task 
Information Button and click advanced option and enter duration. 
 

On Your Own 
 Click duration column and enter days. Mimic the above Gantt chart. 
 Project enters the duration and Gantt bar grows to reflect it. 
 Try the mouse as well. Point the mouse at right edge of task bar and drag 

till the duration you wanted to assign. 
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You can quickly open the task information dialog box by double clicking the task you 
want to update. You can also select Project | Task Information to display the task 
information box.  Alternatively, you can click a task information button--it looks like a 
folder or Press Shift+F2. 
 

 
Figure 14: Viewing Task Information 
 
In the table entry view it is possible to mark a task as a milestone by entering duration of 
“0”. For example, you can double-click “Stage Gate Go/No Go” decision” and enter 0 
days.  See the diagram for the resulting outcome. However, you also can mark a task with 
a longer duration (non-zero) as a milestone.  Double click the task, click Advanced Tab 
of Task information dialog box, click the mark Task as milestone check box to it, and 
click Ok.   
 

Create Milestone 
To mark a task as a milestone, enter duration as “0”. Note you can mark a task with a 
longer duration as a milestone after entering the task duration; just double click the task, 
click Advanced Tab of Task information dialog box, click the mark Task as milestone 
check box to check it and click Ok. 
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Figure 15: Creating a Milestone 
 
It is possible to enter notes for the WBS task as well. This is helpful because, it provides 
more details about the activity as well as data that could not be entered in the columns. 
Such as status of Risk or uncertainty. Click the Notes tab as you see below and enter 
sample data. 
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Figure 16: Adding notes and comments for a task 

 

Create Task Dependencies 
 
Linking tasks sets up a finish-to-start relationship between tasks. When the tasks are 
linked MS Project automatically determines the start and finish date for each task. It also 
calculates the project schedule. 
 

Step 1:  Select the tasks you want to link. E.g. You can highlight tasks 1 and 2 
using your mouse. You will see two tasks highlighted. 
 
Step 2:  Select the “Link Tasks” button from the tool bar. This icon is part of your 
standard toolbar and appears at the top of the screen as a chain. (Alternatively, 
simply Press Ctrl + F2 and that links the tasks.) The result is illustrated in the 
diagram.   
 
Before: We show two simple tasks.  

On Your Own 
 Enter milestones. 
 Enter Durations. 
 Enter a couple of Task Information notes. 
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After: We highlight them and press the link icon   or [Control] + [F2] buttons. The 
result is:  
 

 
 
Also you may double Click on the Task, a dialog box opens up. Click the Predecessors 
Tab. Now you can manually enter the predecessor number. You can change the link to a 
type other than the default Finish-to-Start by adding the abbreviation for start-to-start 
(SS), finish-to-finish (FF), or start-to-finish (SF) link 
 
  
To unlink the tasks, select the “Unlink Tasks” button from the tool bar.  
 

 
 
To link or unlink you can select noncontiguous tasks as well. Choose the first task you 
want to link, then hold down CTRL and choose each individual noncontiguous task you 
want to link. E.g. Select task 4, hold down CTRL, and choose task 6. Then click the link 
button. 
 

 
 

Important: You will notice that when you link tasks, Project 
automatically adjusts your schedule. If instead you enter 
specific start and finish dates for tasks, you override that 
automatic adjustment. In the future, you’ll have to continue to 
make updates manually. 
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Introducing Lag Time and Lead Time 
Sometimes you may want to delay the start of the successor task. This is accomplished by 
introducing a lag time in the successor task. The diagram illustrates how a lag of 4 days is 
introduced after the first task has completed. A good example could be pouring concrete 
for a foundation and then waiting for the concrete to cure and settle for 4 days before you 
continue working on the project.  
 
 In a finish-to-start relationship, if an overlap between the tasks is desired this is referred 
to as Lead-time. Here the start of a successor precedes the finish of its predecessor. 
To create an overlap, use lead time. If a task can start four days before the previous one is 
finished, a lead time of four days gets that successor task to start early. You can 
accomplish this by entering -4d for example.  

On Your Own 
 Enter dependencies for a couple of tasks. Or enter all of them as shown 

in the table below.  
 

 
 

 Practice Unlinking a few dependencies as well. 
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Figure 17: Adding Lag or Lead to a task 

 

On Your Own 
 Click the dependency arrow. You will see the above window. Enter lag 

such as 2 d. Press OK.  
 Also try the following. Double click on Determine Stakeholders. Enter 

the following lag: -2.  
 

 
 
You should see the following screen. 
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Advanced Topics 

Using Filters 
 
Once your project gets large you will need to use filters to query your project. You can 
filter information by clicking the Filter text box list arrow (looks like a funnel) shown in 
diagram below.  
 

 
 
For example, milestones in your project can be filtered by selecting the last option in the 
diagram above. This will show you a Gantt view with summary tasks and tasks with 
duration of zero days. 
 

 
Figure 18: Filtering Tasks to show Milestones and Summary tasks. 
 
 Recap: You can activate filters by clicking View | Gantt Chart (or selecting any other 
view that you want to filter). You then click Project | Filtered For: All Tasks | All Tasks | 
Milestones.  Note that you can create your own filters if the filters in the menu options 
don’t suit your purpose.   
 

 

To remove a filter you must follow these steps. Click Project | Filtered For | 
All tasks. All tasks will now reappear.  
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If you want to display only those tasks associated with a particular resource, you can 
click Project | Filtered For | Using Resource Filter. Note you can view dependencies and 
edit or delete them at this point by clicking on the arrows in the chart. A popup box 
appears that allows you to edit or delete the dependency. 
 

 
 

 

More Scheduling Capabilities to Tasks 
You can add some final details to your project as needed. For example set a deadline for a 
task or assign a calendar to a task, or document notes pertaining to a task, or create 
recurring tasks such as weekly meetings. These are illustrated below. 

To Split a Task 
Select the task and click the Split Task button on the Standard toolbar. Place the splitting 
cursor on the date you want the interruption to begin, and click and drag the task bar to 
the date you want the interruption to end. To Remove a Split merge the split tasks using 
the mouse. You can also use right mouse click button when you have the cursor on the 
Task Bar to activate split task. 
 
When to use split task? For example the package “Lay Garage Foundation” would 
require a week to dry the foundation followed by inspection and some patching. So while 
the effort may be five days, there is five days worth of waiting until the concrete dries 
out. So the package effort is only 40 hours for one person but spans two weeks. If you 
don’t split the task it will show 80 hours of effort. The example below shows how this 
package is split into two. 

Viewing Details for Task or Resource 
Select the task or resource and select View |More Views from the menu. Select Task 
Entry or Resource Entry and click Apply. You will see the Task Form will below 
the Gantt Chart, with additional details about the task or resource. 
 
Using Zoom 
Click the Zoom In button (icon looks like a magnifying glass with plus symbol) on 
the toolbar to zoom in. Click the Zoom Out button on the Standard toolbar to zoom 
out (similar icon with minus sign). 

On Your Own 
 Filter for Tasks associated with Resource Sue (or anyone else in the 

project). 
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Figure 19: Splitting a Task into two 
It is easy to undo the mistake. Press [Control] [Z] keys or simply drag the bars back 
together. 
 
 
 

 

 

Establish Deadline Dates 
To set a deadline click the selected task for which you want to set a deadline and click 
Task information dialog box. Click the Advanced tab and enter the deadline date in the 
Deadline box and click OK. 
 

 
Figure 20: Setting a Task Deadline for Completion 
 

On Your Own 
 Create a simple task called Purchase and Install Memory for laptops. 

Give it two days duration. Split it into two. 
 It should look something like this (with different start and finish dates). 
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Assign a Calendar to Task 
 
If you have created different calendars for different resources, it is then desirable to 
assign them appropriately via tasks. This module is optional.  
 
Right Click on the task that needs a calendar  Click Task information then Dialog Box 
appears. Click Advanced Tab Click Calendar to assign to the task. 
See the view below 

On Your Own 
Notice the arrow (next to the resource name “Joe”).  Move it around.  
 

 
 
Do you get a warning message? See sample below. 
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Figure 21: Assigning a calendar to a task 
 

Create Recurring Tasks 
Some tasks in a project are recurring tasks. A good example is weekly team meeting or 
meeting with a stakeholder or sponsor at a fixed date. In this module we show you how to 
create a recurring task. 
 
 Click the Task in your Gantt Chart 
 Click Insert 
 Click recurring task 
 
Type Task Name then click to set duration then time setting and select start date. 
 

 View different appearances of timing 
 

 Double Click on Time scale then dialog box appears. 
 

 Select number of tiers on Timescale 
 You can click any tier tab to change settings 
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 In middle tier Tab select appearance for the label in tier. 
 

 Click non-working time Tab | Click Draw option | can change color and 
appearance 

Click the Task in your Gantt Chart 

 
Figure 22: Creating Recurring Tasks 
 
 
Select the day for recurrence pattern. Example Tuesday is our recurring meeting date. 
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If you expand Weekly Report you will see 8 occurrences 
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Constraints  
Constraints are restriction that you place on tasks. This affects how Microsoft Project 
calculates the start or finish dates of the tasks in your project. To Set a Task Constraint: 
Select the task and click the Task Information button on the toolbar. Click the Advanced 
tab, select the Constraint type.  If the constraint requires that you specify a constraint date 
(as for all constraints except As Soon As Possible or As late As Possible), use the 
Constraint Date drop-down calendar to select the date. Enter the deadline date in the 
Constraint date box and click OK. 
  
Let us investigate this: Double Click a task called Create Comprehensive Project Plans 

 Select Advanced Tab 
 Select Constraint Type 

You will see the following view 

 
Figure 23: Setting constraints on tasks 
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Critical Path Analysis 
The critical path is used by project managers to monitor and control the project. It is 
called the critical path as it depicts a sequence of tasks associated with the path that has 
the least amount of slack.  
 
For beginners the best option is to use the Critical Path Wizard. This is easily available 
by clicking the following icon on the extreme right of the menu bar. 
 

 
 
This can also be activated by clicking Format | Gantt Chart Wizard from the menu bar.  
 
You will see choices of Standard, Critical path and Baseline.  
 
Select critical path and click next. Project will ask you what type of information you want 
to display with your Gantt bars. Select Resources and click next. You will be asked if you 
want to see a link between depended tasks, click “Yes” followed by “Next” and finally 
click “Format It” and then exit the wizard. Soon you will see your Gantt chart with 
critical path in red. Non critical tasks are blue in color. See snapshot below 

 
 
Figure 24: Formatting and viewing critical path 

 

Resources 
Once you have entered the tasks and duration or effort you can create a resource list. 
Resources are the people, equipment and supplies required to complete the project within the 
defined constraints.  Three different types of resources can be entered using Microsoft 
Project: 



 43

 Work resources  
 Material resources  
 Cost resource  

 
Work resources include equipment and people that work on tasks. Allocation of Time 
and Percentage of assignment of the resource is important. Material resources are good 
used by the work resources and here the units-of-measure is an important gauge. 
Example, 20 cans of paint.  Cost resource is a fixed cost task, cost-dependent on work 
performed. The most common type of resource you will be using the work resource. 
 
In this module our goal is to:  
1. Create resource pool  
2. Assign resources  
 
 

(1) Creating Resource Pool:  
This is a preferred approach. In this option we enter all the resources at once into a Resources 
Spreadsheet. The resources from the resource pool can then be assigned to the tasks. 
Note: You can directly assign a resource to task inside the Gantt View.  If you assign a 
resource to a task in this manner and if it does not exist in the resource pool, MS Project will 
automatically add it to the resource pool. But it will be missing certain data like hourly rates 
or overtime rates. 
 
By using the resource sheet you can enter all the resources at once on a spreadsheet.   If 
you have a list of all the resource you can enter them into a resource sheet by clicking 
View | Resource Sheet or by clicking the Resource Sheet in the View Bar.  

  
 
or 
 

 
Figure 25: Activating Resource Sheet 
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A blank sheet appears and you can enter the data as illustrated in the diagram. Note you 
can also enter equipment here, e.g., Construction excavation equipment that is rented. 
 
Material resources are the goods needed by work resources to complete tasks example 
paint or steel. They help us to track expenses and also determine the rate at which the 
resources are used.  You would enter a Material Label here such as Installation Material 
as follows: Cost/use = $100.  
 

 
Figure 26: Entering Resource Type for Material 
 MS Project provides three cost accrual methods: 
 

1. Start: Choose this if the costs accrue as soon as a task using the resource begins. 
2. Prorated: Choose this if costs accrue as the task progresses, based on the work 

done. This is the default method. 
3. End: Choose this if costs accrue when the task is finished e.g. Fixed costs. 

In our tutorial we use the default values. 

(2) Assigning Resources to Task 
 
Once you have completed the resources sheet you can assign resources to tasks in your 
project. Double click on the task you want to assign a resource to and the task 
information dialog box appears as shown below. Click the Resources tab and you will see 
a drop down list of resources as illustrated in the diagram.  
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Figure 27: Assigning Resources to tasks. 
 
 
Enter the following Resources: 
 
PROJECT VISTA MIGRATION  
INITIATION  
PROJECT KICKOFF Cathy 
DETERMINING STAKE HOLDERS Joe 
CREATE PROJECT CHARTER Anita 
PLANNING  
CREATE COMPREHENSIVE PROJECT PLANS Cathy 
GATHER UPDATE DETAILS FROM MICROSOFT AND 
OTHER SOURCES 

Joe 

TEST VISTA MIGRATION FEASIBILITY Sue 
CREATE SCOPE STATEMENT Anita 
STAGE GATE GO/NO GO DECISION BY CIO Anita 
EXECUTION  
IDENTIFY RESOURCES  FOR CONVERSION Cathy 
PRODUCE VISTA LICENSE KEYS Cathy 
ORDER HARDWARE UPGRADES Joe 
INSTALL HARDWARE AND VISTA "Installation Materials,Joe" 
SETUP TRAINING AND HELPDESK Sue 
STEPS FOR UPGRADING TO WINDOWS VISTA  
ACCESS HARDWARE REQUIREMENTS "Overhead,Joe" 
BACKUP IMPORTANT DATA "Overhead,Joe" 
UPGRADE TO WINDOWS VISTA "Overhead,Joe" 
MIGRATE USER SETTINGS TO VISTA "Overhead,Joe" 
CONTROL AND MONITORING  
MONITOR COST AND SCHEDULE Anita 
MONITORING THE IMPACT ON USERS Anita 
RESOLVING ISSUES/CONCERNS Anita 
CLOSING  
LESSONS LEARNT MEETING "Anita,Cathy,Joe,Sue" 
UPDATE AND ARCHIVE PROJECT DOCUMENTS Anita 
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After you enter resources for various tasks this view will appear: 
 

 
 
 
To make changes in resources for a task you can click on Assign Resources button, which 
is the icon with two people (or use Alt+F10). You can replace the existing resource with 
the new resource by clicking the Replace button, or to remove the resource of the task by 
using the Remove button.  
 
It is useful to document assumptions about the resource by adding some notes. Click the 
resource notes button on the standard toolbar, or right-click the resource and select 
resource notes to enter comments about the resource. 

Over Allocated Resources 
The project manager can easily determine resource over allocation with Microsoft 
Project. You can view over allocated resources in Resource Sheet view, Resource Usage 
view, Resource Allocation view, and Resource Graph view. 
 
Click View, View Bar and select Resource Graph. This allows you to quickly see a graph 
of over allocated resources. 
 
You can level resources over allocation using the following commands: Click View | 
Resource Usage from the menu, and then select Project Filtered For |Over allocated 
Resources from the menu. Select the over allocated resource and select Tools | Level 
Resources from the menu. Click the Manual option and the Level Entire Project option, 
and then click the Level Now button. Next you click the Selected Resources option or the 
Entire Pool option and click OK to complete the leveling.   
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Figure 28: Viewing Over allocated Resources 
 
 

 
 

Updating Project Progress 
Soon your project will start and you will need to update the project plan. Tracking allows 
you to look up specific information, such as how much you spent on resources during a 
particular phase. If you keep your tracking information current, you will have an up-to-
date snapshot of your project. 
 

Setting up a Baseline 
When you have completed scheduling tasks, resources, and costs you should save a 
baseline for your project. A baseline is a benchmark of your project's status before work 
on the project begins. When you save a baseline, Project copies the information from the 
Start and Finish fields into the Baseline Start and Baseline Finish fields. The baseline is 
used evaluate your project progress. To Save a Baseline Plan: Select Tools |Tracking | 
Save Baseline from the menu bar.  Ensure Entire Project option is selected—this is the 
default. Click OK. 
 
Important: If you don’t set up a baseline a lot of your reports will not view 
correctly. Since MS Project wants to compare variance against a baseline. 

On Your Own 
 For two tasks in your WBS that occur on the same date assign the same 

resource. This will result in over allocation.  
 Click View | Resource Usage from the menu, and then select Project 

Filtered For |Over allocated Resources from the menu. 
 Attempt to level the resource over allocation. 
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Updating Project Progress Data 
 
The focus of this tutorial is on updating the schedule, tracking progress, and 
communicating project information to team members and stakeholders.  
You can update a task or groups of tasks.  
 
Click Tools, Tracking, Update Project. This will show the following screen. 
 

 
Figure 29: Updating Project Progress 
  
 
Once the data has been updated it is exciting to see various variance reports. This is 
covered in the next section. 

On Your Own 
 Save the baseline plan 

 The Project Plan for Vista has been submitted and approved. On the 
Tools menu, point to Tracking and then click Set Baseline. 

View baseline data in a Gantt Chart view 
 On the View menu, click Tracking Gantt. In the chart area, the baseline 

information is shown as the lower of the two Gantt bars for each task. 

View baseline and variance data   
 On the View menu, point to Table, and then select Variance. This table 

includes fields for baseline and variance start and finish. 
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Project Progress Views 
The View menu lists several views by default, Calendar, Gantt Chart, Network Diagram, 
Task Usage, and Tracking Gantt.  The Resource related views are: Resource Graph, Sheet 
and Usage.  You can click More Views to see additional Views.  
 
Network Diagram 
Let us look at the Network Diagram view. By selecting it we see the following: 
 

 
Figure 30: Network Diagram 
 
 Task Usage 
The task usage view displays information about the tasks in a project.   The Task Usage 
view can be modified to display a number of different data pertaining to your project, for 
example work effort or cost. We show you these two views below for Project Vista 
 
If you select View Task Usage: Table Usage, you will see a view such as: 
 
 

On Your Own 
 Updating a Range of Dates: To Update Project Progress: Select Tools | 
Tracking | Update Project from the menu. Select the date through which you 
want to update the project. Click OK.  
 
Updating Task Completion Percentage: To Update Task Completion Percentage: 
Identify the task and then select Tools | Tracking | Update Tasks from the menu. 
Enter the %.   
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Figure 31: Task Usage View 
 
If you select View Task Usage: Table Cost, you will see a view such as: 

 
Figure 32: Cost View 
 
  
Play with the following interesting views and see how they can help you to track project 
progress:  
 
Project Statistics: You can view project statistics at any time by clicking the following on 
the menu bar:  Project | Project Information | Statistics button. 
 
Project Costs: Select View | More Views from the menu, select Task Sheet, and click 
Apply. Select Tools | Options from the menu and click the View tab. Check the Show 
Project summary task checkbox and click OK. Select View | Table: Cost from the menu. 
 
Duration Variance:  Select View | More Views from the menu, select Task Sheet, and 
click Apply. Select View | Table: Variance from the menu, and then look at the Start Var. 
and Finish Var. fields to see the amounts of variance calculated for the start and finish of 
the task. 
 
Cost Variance: Select View | Task Sheet from the menu, and then select View | Table: 
Cost from the menu. Check the Variance field to view variance in cost. 
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Determining Delayed Tasks: Select View | Tracking Gantt from the menu, and then select 
View | Table: Variance from the menu. Here you can compare the current project status 
with the baseline. 
 
Note the calendar view is possibly the most popular view after the Gantt Chart. When 
you right-click the chart portion of any view, short cut menu appears with commands that 
can let you format a particular chart. Also don’t forget that you can sort and filter data in 
a sheet as well as adjust time scales. Printing is covered in the next topic. However it is 
worthwhile indicating here that printing the Current View as a Report is pretty 
straightforward.  Click the Report button list arrow on the Project Guide toolbar and 
select Print current view as a report from the list. The wizard walks you through several 
steps; click the Print button when finished. 
 

Working with Reports 
 
Reports are used throughout the project to communicate project status and information to 
the project team and to project stakeholders. In this section you will get an overview of 
various reports that Project offers and how to print them. There are several excellent 
visual reports that you can display and print as well. You can print the views you saw in 
the earlier section as well as print the standard reports. To see the standard reports that 
comes with Project select Report followed by Reports. You will see six categories of 
reports such as:  Overview, Current Activities and Costs. Click the Overview reports and 
this will show you five different categories of reports such as Project Summary and 
Milestones.  
 

 
Figure 33: Printing Reports 
 
 
You may want to sort a report first. To sort a report select a report and click the Edit 
button, if the report can be sorted, the Task Reports dialog box will appear. Click the Sort 
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tab, select your sorting options, and click OK.  Preview your sorted report and see if this 
is suitable before printing. 
 
Adding Page Elements to a Report:  Open a report. In Print Preview, click the Page Setup 
button. In the Page Setup dialog box, use the various tabs to add page elements to your 
report.  
 

 
 
 

 

Reports are easy to print: Click File | Print from the menu bar. Choose your print 
options then click OK.  Small reports that can fit on a page should be formatted as 
such. You might want to select landscape, and fit on one page— preview this report 
and only then print.  

 
ON YOUR OWN 

1. Print a view as a report  
 Set up the current view the way that you want it to look when 

printed. On the File menu, click Print Preview to check the 
view layout. To print the view, click Print. 

2. Generate a report On the Report menu 
 Click Reports. Double click a report category and then double 

click the predefined report. Enter any requested information. A 
preview of the report appears. To print the report, click Print. 

4. Add a field (column) to a table 
 Click anywhere in a column to the left of where you want to 

insert a new column. On the Insert menu, click Column. 

 In the Field name box, click the name of the field that you want 
to add as a new column. 

5. Customize views 
 On the View menu, click More Views. Click New or Edit. In 

the View Definition dialog box, specify the table, group, and 
filter that you want to use to define the view. 

6. Customize tables On the View menu, 
 Point to Table, and then click More Tables. Click New or Edit. 

In the Table Definition dialog box, specify the information that 
you want to include in the table.8 
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Optional: Cool Stuff 
There are three cool things you should experiment as soon as you can: exporting data, 
exporting images and linking projects. 

Export Data to Excel Spreadsheet 
A lot of managers would like to see the project data as an excel spreadsheet or even plain 
text.  The best way to do this is simply copy and paste. Try it out. Highlight the tasks 
including dates, copy and paste to Microsoft Excel. Resize and format the columns in 
excel and you are done. Note: There is a Save As Excel Work Book option as well. But 
this requires mapping to a template. 

Exporting Images 
A really cool feature that you will like is copying pictures of any view in your project by 
clicking Copy Picture icon on the Standard toolbar (looks like a camera). The data is 
captured in a picture and copied to the Clipboard. A wizard appears that allows you to 
select range or type of image and gives your other custom options. If you select GIF, you 
can now paste this data in all applications other than simply Office applications 

Linking Projects 
This is incredibly easy and very powerful. Assume that you have two projects. Project 
Linux and Project Vista and you want to integrate the two projects. Simply click Insert 
Project and that will integrate the timeline. If you make changes to data in one project it 
will be reflected automatically in the other.  

Summary: Key Points to Remember 
You can use the project guide to get you going. Subsequently the key steps you will 
follow are: 
 

 Enter tasks and their durations  
 Link tasks 
 Delete tasks 
 Insert tasks 
 Move tasks 
 Enter a milestone  

 
Summary tasks identify the major phases of a project. They consist of one or more 
subordinate tasks indented below them. You can view the different summary levels by 
selecting the outline. 
 
Microsoft Office supports the four dependency types introduced in this book. 
 
Finish-to-Start (FS):   The successor task cannot start until the predecessor task finishes. 
When you link two tasks, the Finish-to-Start dependency is created by default.   
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Start-to-Start (SS):   The predecessor task must start when the successor task starts. Use 
of this dependency can decrease the overall duration of a project. Tasks can overlap or be 
done in parallel. 
  
Finish-to-Finish (FF):   The predecessor task must finish when the successor tasks 
finishes. . Use of this dependency can decrease the overall duration of a project. Tasks 
can overlap or be done in parallel. 
 
Start-to-Finish (SF):   The successor task cannot finish until the predecessor task starts. 
This is not widely used. 
   
Lag time is a delay between tasks while Lead time is overlap between tasks that have a 
dependency. You enter lag time or lead time in the Lag field in the Task Information 
dialog box or in the Predecessors field of a successor task. A negative number is used for 
lead time. 
 
By using the resource sheet you can enter all the resources at once on a spreadsheet.  The 
resources from the resource pool can then be assigned to the tasks. 
 
Even though we have focused only on a single project in this tutorial, Microsoft Project 
allows you to work with and manage multiple open project files. This includes ability to 
consolidate project files and working with a shared resource pool. 
 

References: 
 

1. MBA Fundamentals Project Management, Kaplan Publishing, 2008. 
2. Microsoft Project 2007 Online documentation, Microsoft Corporation. 

 

Important: Project 2007 QUICK Reference Card  from a third party is a useful resource. 
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Appendix: Earned Value Tutorial  
 
In case study we illustrate a simple project done by one person “Joe”, who plans to 
complete the project in 30 days. It has five packages of five days duration each. Joe earns 
$50 per hour. The project will start on 2/18/2010. We plan to inspect the project after the 
second task is complete (build garage) and print an earned value report. 
 
1. Create a file 

 
 
2. Sequence the tasks. Highlight all the above and click the link tasks button (chain). 
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3. Click the Resource button and select Joe. 

 

4. Give him hourly rates of $50. 
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5. Click Reports, Report, Cost, Budget ---Check the Budget for Project 

 
6. Save a baseline 

 
 
7. View Tracking Table, Inside Track View complete the first task with no delays. 

Complete the second task with 10 days (5 days duration schedule overrun).  
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8. Fast-forward the Project to Actual Finish date. Click Project, Project Information, 

Actual date. In our case it is end of 3/10/10. Your date might be different. 

 
 
 
9. Click the following. View Tracking Gantt, Table: Tracking 
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10. You will see corresponding  Bar charts as follows: 

 
11. Print Earned Value Report. Click Report, Reports, Click Costs and select Earned 

Value 
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12. Your report will look like something like this. 

 
 
Analysis: The duration delay is translated to Actual Costs of $4000 for Build Garage. 
Conclusion: Read the summary line to assess the health of the project. It is $2000 over 
budget and this corresponds to a $2000 schedule variance.  
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Appendix B: Videos 

See Videos based on Kanabar/Warburton Text. 

1. Introduction 
2. Resources & Cost 

 

Useful FREE Video Tutorials from MS Project 
Project HELP (F1 key) within MS PROJECT 2007.  Go to the bottom and you will find 
several videos. Practice them on a simple project with two tasks.   

Watch this: Hide or show a column 
Watch this: Create a visual report 
Watch this: Set up a recurring task 
Watch this: Split a task 
Watch this: Use lag and lead time 
 
Watch this: Create a baseline 
Watch this: Show the critical path 
 
Watch This: Filter your project quickly with autofilters 
Watch this: Scroll to a task quickly 
Watch this: Group tasks or resources 
Watch this: Use a PERT analysis 

 
Optional 
Watch this: Group tasks or resources 
Watch this: Use a PERT analysis 

Watch this: Create a budget 
 


